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学习之前，请到 http://www.axure.com 官方网站下载和安装 Axure。 

入门篇 

第一章  介绍 

第1节 认识 Axure RP 

1. 什么是 Axure RP 

Axure 的发音是“Ack-sure”，RP 则是“Rapid Prototyping”的缩写。Axure RP Pro

是美国 Axure Software Solution 公司的旗舰产品，是一个快速的原型工具，主要是针对负

责定义需求、定义规格、设计功能、设计界面的专家，包括用户体验设计师（UX）、交互设

计师（UI）、业务分析师（BA）、信息架构师（IA）、可用性专家（UE）和产品经理（PM）。 

Axure能让你快速的进行线框图和原型的设计，让相关人员对你的设计进行体验和验证，

向用户进行演示、沟通交流以确认用户需求，并能自动生成规格说明文档。另外，Axure还

能让团队成员进行多人协同设计，并对设计进行方案版本控制管理。 

Axure使原型设计及和客户的交流方式发生了变革： 

 进行更加高效的设计； 

 让你体验动态的原型； 

 更加清晰的交流想法； 

2. 原型的作用和好处 

“没有比制作 prototype 更易取得使用者界面与特殊功能可用性上的一致性了。

Prototype不只可确认需求，它更可赢得顾客的心。” 

——阿伦 M.戴维斯 和 迪安 A. 莱芬韦尔 

《用需求管理快速交付高质量的软件》的作者（Rational 软件公司/IBM） 

根据调查报告显示，大约 66%的软件开发不是失败，就是超预算、延期或交付缩水的功

能。软件失败或亏损的前三大原因为： 1、缺乏使用者的参与；2、需求或规格不完整；3、

需求或规格变更； 

传统的需求管理工具或工作表中所储存的数千个需求与上百页的文件早已不合时宜。现

在，这些需求更是不适用于目前快速发展的环境。而制作 Prototype是个有效的简化文档编

制、吸引使用者参与、早期辨认需求遗漏、将外在需求风险降到最低的方法。将大量文字性

http://www.axure.com�ٷ���վ���غͰ
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文档转变为带有注释与互动性的可视画面，如此更能抓住利益相关者与使用者的注意，让用

户在软件开始投入编程前就确认需求。 

快速原型法（Rapid Prototyping）是一种有效且高效的以用户为中心（User-Centered 

Design）的技术，可以帮助用户体验专家、设计师、工程师创造更加有用、可用的产品。 

目前全球有财富 1000 大的公司和重要机构在使用 Axure RP，国内的淘宝、雅虎、腾讯、

当当等公司的产品经理也都在使用。 

3. Axure 的工作环境 

Axure的工作环境可进行可视化拖拉操作，可轻松快速的创建带有注释的线框图。无需

编程就可以在线框图中定义简单链接和高级交互。Axure可一体化生成线框图、HTML交互原

型、规格说明 Word文档。以下是对 Axure RP工作环境的简要说明： 

 

1. 主菜单和工具栏（Main Menu & Toolbar） 

执行常用操作，如文件打开、保存、格式化控件、输出原型、输出规格等操作。 

2. 页面导航板（Sitemap Pane） 

对所设计的页面进行添加、删除、重命名和组织。 

3. 控件面板（Widgets Pane） 

该面板中有线框图控件和流程图控件，用这些控件进行线框图和流程图的设计。 

1 
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4. 模块面板（Masters Pane） 

模块是一种可以复用的特殊页面，在该面板中可进行模块的添加、删除、重命名和组织。 

5. 线框图面板（Wireframe Pane） 

在线框图面板中可以进行页面线框图的设计，线框图面板也就是进行页面设计的工作区。 

6. 控件交互面板（Interactions Pane） 

定义控件的交互，如：链接、弹出、动态显示和隐藏等。 

7. 控件注释面板（Annotations Pane） 

对控件进行注释定义和对控件的功能进行说明。  

8. 页面交互和注释面板（Pages Notes & Page Interactions Pane） 

添加和管理页面的注释和交互。 

第2节 线框图及其注释 

1. 页面导航面板（Sitemap） 

在绘制线框图(Wireframe)或流程图（Flow）之前，应该先思考界面框架，决定信息内

容与层级。明确界面框架后，接下来就可以利用页面导航面板来定义所要设计的页面。 

页面导航面板是用于管理所设计的页面，可以添加、删除及对页面层次进行重新组织。 

页面的添加、删除和重命名 

点击面板工具栏上的“Add Child Page”按钮可以添加一个页面，点击 “Delete Page”

按钮可以删除一个页面。右键单击选择“Rename Page”菜单项可对页面进行重命名。 

 

页面组织排序 

在页面导航面板中，通过拖拉页面或点击工具栏上的排序按钮，可以上下移动页面的位

置和重新组织页面的层次。 

http://www.axure.com/p101_2.aspx
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打开页面进行设计 

在页面导航面板中，鼠标双击页面将会在线框面板中打开页面以进行线框图设计。 

2. 控件（Widgets） 

控件是用于设计线框图的用户界面元素。在控件面板中包含有常用的控件，如按钮、图

片、文本框等。 

 

添加控件 

从控件面板中拖动一个控件到线框图面板中，就可以添加一个控件。控件可以从一个线

框图中被拷贝(Ctrl+C)，然后粘贴(Ctrl+V)到另外一个线框图中。 

操作控件 

添加控件后，在线框图中点选该控件，然后可以拖拉移动控件和改变控件的大小，还可

以一次同时对多个控件进行选择、移动、改变尺寸。另外，还可以组合、排序、对齐、分配

和锁定控件。这些操作可通过控件右键菜单中进行，也可在 Object工具栏上的按钮进行。 

编辑控件风格和属性 

有多种方法可以编辑控件的风格和属性： 

 鼠标双击：鼠标双击某个控件，可以对控件的最常用属性进行编辑。例如，双击一

个图片控件可以导入一张图片；双击一个下拉列表或列表框控件可以编辑列表项。 

 工具栏：点击工具栏上的按钮可编辑控件的文本字体、背景色、边框等。 

 右键菜单：控件右键菜单上可编辑控件的一些特定属性，不同控件这些属性也不同。 
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3. 注释（Annotations） 

可以为控件添加注释，以说明控件的功能。 

添加注释 

在线框图中选择控件，然后在控件注释和交互（Annotations and Interactions）面板

中编辑字段中的值，即可为控件添加注释。面板顶部的 Label字段是为控件添加一个标识符。 

 

自定义字段（Fields） 

通过主菜单 Wireframe->Customize Annotation Fields and Views或点击面板上

Annotations头部的“Custommize Fields and Views”，然后在弹出的 Custommize Fields and 

Views对话框中可以添加、删除、修改、排序注释字段。 

 

控件的标识符 

控件的注释字段，并且

可以自定义这些字段 
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脚注（Footnotes） 

在控件上添加注释后，控件的右上角会显示一个黄色方块，称为脚注。脚注号码可以增

大和减小，可通过控件右键菜单或工具栏上的 进行修改。 

4. 页面备注（Page Notes） 

页面备注可是对页面进行描述和说明。 

添加页面备注 

在线框图下面的 Page notes 面板中可以添加页面备注内容。 

 

管理页面备注 
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另外，可以自定义页面备注，为不同的人提供不同的备注，以满足不同需要。比如可以

新增“测试用例”、“操作说明”等不同类别的页面备注。当输出规格文件时，可以指定哪些

页面备注要输出。 

 

要添加页面备注，点击主菜单“Wireframe->Manage Page Notes”或点击页面备注面板

上的“Page Notes - Default”旁边的箭头按钮，然后选择“Manage Page Notes”，将出现

页面备注对话框，然后就可以添加、删除、重命名、排序备注字段。 

 

要在备注字段间进行切换，可以点击“Page Notes – Default”旁边的箭头按钮，然

后选择要添加备注的字段。 

第3节 基本交互设计 

1. 控件的交互 

控件交互面板用于定义线框图中控件的行为，包含定义简单的链接和复杂的 RIA 行为，

所定义的交互都可以在将来生成的原型中进行操作执行。 
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在控件交互面板中可以定义控件的交互，交互由事件（Events）、场景（ Cases）和动

作（Actions）组成： 

 用户操作界面时就会触发事件，如鼠标的 OnClick、OnMouseEnter和 OnMouseOut； 

 每个事件可以包含多个场景，场景也就是事件触发后要满足的条件； 

 每个场景可执行多个动作，例如：打开链接、显示面板、隐藏面板、移动面板。 

 

事件、场景和动作的关系 

目前 Axure RP 5 支持的事件如下： 

 OnClick：鼠标点击 

 OnMouseEnter：鼠标的指针移动到对象上  

 OnMouseOut：鼠标的指针移动出对象外  

 OnFocus：鼠标的指针进入文字输入状态（获得焦点）  

 OnLostFocus：鼠标的指针离开文字输入状态 （失去焦点）  

 OnPageLoad：页面或模块载入 

大多对象只具备常见的三种触发事件：OnClick、OnMouseEnter 与 OnMouseOut，一些

特殊的控件可触发的事件有些不同： 

 按钮控件只有 OnClick 

 单选框和复选框则具有 OnFocus、 OnLostFocus 

事件

场景1

动作1

动作2

场景2

动作1

动作2
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 文本框、文本域、下拉框、列表框则具有 OnKeyUp、OnFocus、OnLostFocus  

 页面加载或模块被载入时则发生 OnPageLoad 

2. 定义链接 

下列步骤说明如何在按钮控件上定义一个链接： 

1. 首先，拖拉一个按钮控件到线框图中，并选择这个按钮； 

2. 然后，控件交互面板中鼠标双击“OnClick”这个事件，这时会出现“Interaction Case 

Properties”对话窗，在这个对话框中可以选择要执行的动作； 

3. 在“Step 2”中，勾选“Open Link in Current Window”动作。  

4. 在“Step 3”中，点击“Link”，在弹出的 Link Properties 对话框中可以选择要链接

的页面或其它网页地址 

 

除了上面的步骤，加入一个链接的最快的方法是单击控件交互面板顶部的“Quick Link”，

在弹出的 Link Properties 对话框中选择要链接的页面。 

3. 设置动作 

除了简单的链接之外，Axure还提供了许多丰富的动作，这些动作可以在任何触发事件

的场景中执行。 
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以下是 Axure所支持的动作： 

 Open Link in Current Window：在当前窗口打开一个页面 

 Open Link in Popup Window：在弹出的窗口中打开一个页面 

 Open Link in Parent Window：在父窗口中打开一个页面 

 Close Current Window：关闭当前窗口  

 Open Link in Frame：在框架中打开一个页面 

 Set Panel state(s) to State(s)：为动态面板设定要显示的状态  

 Show Panel(s)：显示动态面板 

 Hide Panel(s)：隐藏动态面板 

 Toggle Visibility for Panel(s)：切换动态面板的显示状态（显示/隐藏） 

 Move Panel(s)：根据绝对坐标或相对坐标来移动动态面板 

 Set Variable and Widget value(s) equal to Value(s)：设定变量值或控件值  

 Open Link in Parent Frame：在父页面的嵌框架中打开一个页面  

 Scroll to Image Map Region：滚动页面到 Image Map所在位置  
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 Enable Widget(s)：把对象状态变成可用状态  

 Disable Widget(s)：把对象状态变成不可用状态  

 Wait Time(s)：等待多少毫秒(ms)后再进行这个动作  

 Other：显示动作的文字说明 

4. 多个场景（条件） 

一个触发事件可以包含有多个场景，根据条件执行流程或互动。 

 

例如，可以在一个按钮的 OnClick触发事件中加入两个场景，第一个场景可以加入一个

条件说明(“If Yes”)并执行第一个动作；第二个场景则可加入另一个条件说明(“If No”)

并执行第二个动作。 

 

当在原型中按下按钮时，会显示出这两个条件说明(“If Yes”和“If No”)，点选其

中一个条件说明，就会执行该条件所关联的动作。 

使用条件说明可以有效操作条件流程，但如果需要建立一个高保真的原型，则必需在条

件中定义条件逻辑：根据控件的值或变量值执行动作。（关于条件逻辑，见第四章高级功能） 

5. 页面上的事件: OnPageLoad 

Axure支持一个页面层级的触发事件：OnPageLoad，这个事件在原型载入页面时触发。 

 

页面OnPageLoad 事件在页面备注面板中的Interactions子面板中定义，为OnPageLoad 

事件添加场景的方式与控件事件相同。（详见第四章第 6节） 
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第4节 使用模块（Master） 

1. 什么是模块 

模块是可以重复使用特殊页面。一些常用模块如页首(Header)、页尾(Footer)与导航

(Navigation)。模块可用在页面中或是其他模块中。只要修改模块，在所有页面中引用这个

模块的模块实例也会随即全部跟着变化。 

模块的概念犹如 PowerPoint 中母版、Dreamveawer中模板的概念，熟练掌握模块可以

大大提高原型设计的效率，并易于维护管理。 

2. 模块的添加、设计和组织 

在模块面板中可进行模块的管理。 

要添加模块，单击模块面板顶部的工具栏上的“Add Master”按钮；或在面板中点鼠标

右键，选择“Add Master”。 

模块面板中可利用文件夹(Folder)来组织模块，然后通过工具栏、快捷菜单或是拖拉的

方式重新排列模块。 

在模块上双击鼠标打开模块，像设计页面一样拖拉控件到线框图面板中进行模块设计。 

 

3. 页面中使用模块 

只要拖拉模块面板中的模块到线框图中，就可以在页面或另外模块中应用模块。拖入到

线框图中后，根据模块特性，模块对象会有淡红或灰色的遮罩，执行菜单 “Wireframe->Mask 

Masters”可以移除遮罩。 
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模块预设行为（Behavior）是“Normal”，可以在模块面板中的模块上点鼠标右键，然

后利用“Behavior”子菜单将它的行为修改为“Place In Background”或“Custom Widget”。 

 

模块的行为说明如下：  

Normal: 模块可以被移动与放置在线框图中的任何地方，对模块修改后，所做的修改会

在该模块的所有使用实例中反映出来。 

Place in Background: 模块应用在线框图中时，会处于线框图的最底层并被锁定，所

包含控件的位置与在模块中的位置相同，常用于作为模板、布局、底板。 

Custom Widget: 模块应用在线框图中时，模块中的控件与模块失去关联，模块中的控

件可以像一般控件一样进行编辑，就好像只是进行了复制。常用于创建具有自定义属性、注

释和交互的自定义控件库，例如：具有白色文字的蓝色按钮。 

第5节 HTML 原型 

1. 什么 HTML 原型 

在 Axure中设计了带注释的线框图并定义了交互之后，就可以产生一个可以互动的、基

于浏览器的原型了。Axure 原型是一些 HTML和 JavaScript 文件，可以在 IE6+、Mozilla、

Firefox浏览器中执行。 

2. 配置和生成原型 

点击主菜单“Generate->Prototype (F5)”或工具栏上的 Prototype按钮，可以配置和

生成原型，在打开的 Configure HTML Prototype对话框中，可以对原型进行配置。 

http://www.axure.com/p101_5.aspx
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配置选项分为以下部分： 

 General：在“Destination Folder”位置输入 HTML原型的存放位置。由于 Axure 

HTML原型包含多个文件，最好指定一个单独文件夹专门存放这个原型。 

 Notes：选择和排序想要显示在 HTML原型中的页面说明。 

 Annotations：选择和排序想要显示在 HTML 原型中的注释字段。 

 Interactions：指定交互行为，例如：指定是否需要总是显示场景描述(case)，或

是只在多个场景存在的情形才显示。 

 Distribution：选择是否生成 chm文件。 

 Advanced：选择是否将 Text Panel转成图片，这是旧版本的一个功能，很少使用。 

 

配置完毕后，就可以点击 Generate按钮生成原型。 

3. 重新生成页面 

当 Axure工程会越来越大时，输出 HTML原型的时间也会越来越慢。如果只是调整其中

一个页面，却要等待整个原型重新全部输出，那就太浪费时间了。 
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要重新生成某一个页面，只打开这个页面，然后选择主菜单“Generate->Regenerate 

Current Page to Prototype(CTRL+F5)”，回到 HTML原型中刷新就可以看到更新的页面了。 

 

4. 浏览和操作 HTML 原型 

Axure输出的 HTML原型的界面可分成三个区域： 

左侧: 是一个页面导航列表，以层级形式展示原型中页面。 

底部: 显示当前页面的备注说明，即页面备注。 

中间: 显示线框图和流程图，线框图可以按照所设计的交互进行鼠标和键盘的互动。 

 

另外，单击控件旁边的黄色便利贴小图标可以阅读控件注释。 
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5. 分发原型 

Axure原型是一些 HTML、Javascript和图像文件，可以在主流的浏览如 IE6+、Firefox 

中进行浏览。所以你的同事和客户不需要安装 Axure 或任何播放器就可以直接浏览原型。 

发布 Prototype的方式有很多种： 

1、发布到 web服务器 

第一种方式是发布 HTML原型到 Web服务器上，只要将网址告诉客户、工作伙伴或其他

人，他们就可以在浏览器上浏览原型。 

2、 压缩成 ZIP压缩包 

第二种方式是将原型压缩成 ZIP压缩包，然后将 ZIP压缩包传递给相关的人。其它人将

ZIP包解压缩后，便可以直接在自己的计算机上浏览 HTML原型。 

3、 发布为 CHM文档 

第三种方式是产生包含原型的 CHM档，就像 ZIP 压缩包一样，这种方式是将原型发布为

一个单独的文档，不需安装任何软件就可以访问。CHM 是 Microsoft HTML Help 格式文档，

因为大多数的Windows计算机已经安装了浏览器，所以使用者只要打开CHM文档就可以访问。 

 

想要将原型输出为 CHM文档，请在 Configure HTML Prototype对话框中的 Distribute

中，勾选“Create HTML Help File(.chm)”选项。如果你未安装 HTML Help Workshop的话，

就必须先安装它才能产生 CHM档。安装完成 HTML Help Workshop 后，所安装的文件夹中将

会出现一个 hhc.exe的文件，单击“Locate hhc.exe”链接到 hhc.exe文件的位置。最终产

生的 CHM原型文档存放原型所在的文件夹中。 
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第6节 输出规格说明 

1. 什么是规格说明书（Specification） 

设计完线框图后，就可以输出 Word格式的需求书或功能性规格文件(Specification)。

默认的规格书生成器是 Word 2007 (.docx文件)，需要安装 Word 2007以生成和阅读.docx

文件。另外，你也可以设置 Word2000作为规格书生成器。 

如果没有安装 Word 2007，可以安装 Microsoft Office Compatibility Pack 兼容包，

然后就可以让 Office2000/XP/2003打开、创建、编辑、保存 2007文件格式了。如果你未安

装 2007或兼容包，它会和 Axure一起安装。 

在设计线框图时，如果把需求说明或规格描述写在了页面备注或控件注释中，生成规格

文件时，Axure会自动汇总这些文字和插图，按照顺序出现在 Word文档中。 

 

以下规格说明书范例，可以让你快速了解 Axure 输出的规格书大概是什么样子: 

 Axure RP Prototype 范例-旅游网站企划书(Word 2000 格式) 1.7 M bytes  

 Axure RP Prototype 范例-旅游网站企划书(Word 2007 格式) 700 k Bytes  

（以上文件来自 http://userxper.com，是一个台湾的 Axure 网站，繁体中文） 

http://userxper.com/samples/zh/Spec/demo_travelsite.doc
http://userxper.com/samples/zh/Spec/UserXper-TravelSite-Sample.docx
http://userxper.com/
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2. 设置规格说明书的格式 

要输出规格书或设定输出格式，选择主菜单“Generate->Specification(F6)”或点击

工具栏中的“Specification”按钮，在 Configure Word 2007 Specification 对话框中，

可以设置规格文件的输出格式。 

可设置的项目包括：Pages（页面）， Masters（模块）， Notes（页面说明），Screenshot 

（界面插图）， Annotations（控件注释），Widgets（控件）， Word Template (Word 模板)。 

设定 word模板可以客户化输出的规格文件，让文件的表现更专业，也可以事先设定好

前言和附录文件，如封面、附录、签名页。还可以修改 Word模板来配置规格中的文字样式，

改变文件的排版或加入页首、页尾。 

 

设置完毕后，点击 Generate按钮可以输出规格书。 
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第二章  流程图（Flow Diagrams） 

第1节 流程图和连接线 

1. 什么是流程图 

一个流程图可用于展示各种各样的处理流程，包括用例流程、商业流程、页面流程等。

在 Axure中，流程图常用于提供一个高保真的、能通过所设计的页面来完成的任务视图。一

张简明的流程图，能促进和其它设计师、开发工程师的交流，节约口头沟通的成本，并且能

点出一些关键性问题。流程图能使思路清晰、逻辑清楚，并且有助于程序的逻辑实现和有效

解决实际问题。 

 

流程图其实也是页面，只要修改页面类型为流程图即可。在页面上点击右键，选择

“Diagram Type->Flow”，这时在页面前图标会变为一个 图标。 
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注意：要创建流程图并不是一定强制要将页面指定为流程图，指定为流程图只是方便识别。 

2. 流程控件 

在控件面板中的顶部工具栏上点击“flow”按钮可以找到流程控件，这些流程控件用于

表达流程中的步骤。Axure里面由于不涉及到具体的程序流程，所以有些标准的图形并没有

提供，如不规则图形、侧面双矩形等，如果这些流程控件不满足你的流程需要，可由图片控

件进行合成。 

流程控件的使用有一些约定习惯，但是 Axure 并没有对如何使用这些形状进行强制约束。

一般地，你应该以其他人能够理解的方式进行使用。你可以自己自定义一套符号标准，进行

使用。 

 

1、 rectangle：矩形 

作用：一般用作要执行的处理（process），在程序流程图中做执行框。在 Axure中如果

是画页面框架图，那么也可以指代一个页面。你可把页面和执行命令放在同一个流程中

做说明，这个时候将两类不同的矩形做色彩区别，然后做说明就好了。 

2、 rounded rectangle：圆角矩形或者扁圆 

作用：表示程序的开始或者结束，在程序流程图中用作为起始框或者结束框。 

3、 beveled rectangle：斜角矩形 

作用：斜角矩形我几乎不使用，可以视情况自行定义。或者在其他的流程图中，有特殊

含义，暂不知晓，也希望有识之士指点一二。 

4、 diamond：菱形 

作用：表示决策或判断（例如：If„Then„Else）,在程序流程图中，用作判别框。 

5、 file：文件 

作用：表达为一个文件，可以是生成的文件，或者是调用的文件。如何定义，需要自己

根据实际情况做解释。 

6、 bracket：括弧 
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作用：注释或者说明，也可以做条件叙述。一般流程到一个位置，做一段执行说明，或

者特殊行为时，我会用到它。 

7、 semicircle：半圆形 

作用：半圆在使用中常作为流程页面跳转、流程跳转的标记。 

8、 triangle：三角形 

作用：控制传递，一般和线条结合使用，画数据传递。 

9、 trapezoid：梯形 

作用：一般用作手动操作。 

10、 ellipse：椭圆形或圆形 

作用：如果画小圆，一般是用来表示按顺序数据的流程。如果是画椭圆形，很多人用作

流程的结束。如果是在 use case用例图中，椭圆就是一个用例了。 

11、 hexagon：六边形 

作用：表示准备之意，大多数人用作流程的起始，类似起始框。 

12、 parallelogram：平行四边形 

作用：一般表示数据，或确定的数据处理。或者表示资料输入（Input）。 

13、 actor：角色 

作用：来自于 use case 用例，模拟流程中执行操作的角色是谁。需要注意的时，角色

并非一定是人，有时候是机器自动执行，有时候也可是模拟一个系统管理。 

14、 database：数据 

作用：就是指保存我们网站数据的数据库。 

15、 image：图片 

作用：表示一张图片，或者置入一个已经画好的图片、流程或者一个环境。 

3. 流程连接线 

流程图控件和线框图控件的不同点在于流程控件可以通过连接线进行连接。 

要添加连接线，可以点击主工具栏上的“Connector Mode button (F11)”按钮，这时

线框图面板会从指针状态切换到连接状态，再点击“Pointer Mode button (F9)”可以切换

回到指针状态。 
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在连接状态时，在流程图中点击和拖动就可以绘制和添加连接线。例如，要连接两个流

程控件，将鼠标放在一个流程控件的连接点上，点击和拖拉，然后鼠标在另一个目标流程控

件的连接点上松开，就可以完成连接。点击和拖动连接线的尾部端点可进行重新连接。 

 

选择流程连接线，然后点击工具栏中的“Line Pattern ”和“ Line Ends”按钮可以

修改连接线的形状和样式，如箭头、虚线。 

4. 创建流程图 

与线框图控件相似，你可以拖拉流程图控件到线框面板中，可以通过工具栏和右键菜单

来修改流程图形状的风格和属性。另外，已经绘制好的流程形状可以通过控件右键菜单中的

“Edit Flow Shape”的子菜单进行流程图形的转变。 

5. 流程图中引用页面 

可以在流程图控件上分配一个引用页面，如果流程图控件引用了一个页面，控件上的文

本会变成页面的名称。在原型中点击引用了页面的流程控件可以自动链接到页面中。 

在页面导航面板中拖拉页面到线框图或流程图中，将会创建一个引用了页面的流程图控

件。流程图控件上所引用的页面可以通过在控件上的右键菜单 “Edit Flow Shape->Edit 

Reference Page”进行编辑和清除。 
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引用页面后，控件左上角会有一个“页面”图标进行标识： 

 

第2节 自动生成流程图 

1. 生成流程图 

可以根据页面导航面板中的页面层级关系自动产生流程图： 

1、首先，创建一个流程图页面，并双击打开； 

2、然后，在页面导航面板中你想要生成流程图的分支根节点上点击右键，然后选择

“Generate Flow Diagram”，你将看到两个选项：Standard digram 或 Right Hanging。选

择其中一个就可以在线框图面板中产生一个流程图。 
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所生成的流程图是根据你所选择的页面和子页面的层级关系，并且会自动引用对应的页

面。可以像一般的流程图一样编辑修改自动生成的流程图。 

第三章  高级交互设计（Rich Interaction） 

第1节 动态面板（Dynamic Panel） 

1. 动态面板控件 

动态面板控件可以让你的原型中实现高级的动态交互功能。 

 

动态面板包含有多个状态（states），每个状态可包含一系列控件。任何时候都只有一

个状态是可见的，或这整个动态面板可以被隐藏。 

结合交互动作，可以让动态面板的状态进行隐藏、显示和改变。像其它控件一样，可以

在控件面板中拖拉动态面板控件，将动态面板控件添加到线框图中。 

2. 编辑动态面板的状态 

在线框图中，双击动态面板可以打开一个“Dynamic Panel State Manager”对话框，

在对话框中你可以创建、重命名、重新排序、删除和编辑动态面板的状态。 
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第一个状态是动态面板的默然状态。在对话框中选中一个状态，然后点击“Edit State”

按钮，就可以中打开一个状态线框图进行状态设计。状态设计和线框图设计是一样的，状态

线框图中的蓝色虚线外框表示动态面板的范围边界。 

3. 隐藏动态面板 

可以设置动态面板在默认时隐藏，只要选择动态面板，右键菜单选择“Edit Dynamic 

Panel->Set Hidden”即可。这将会隐藏面板内容，动态面板的遮罩会由蓝色变为黄色。 

 

4. 交互动作和动态面板 

交互动作可以引发动态面板的交互。在“Interaction Case Properties”对话框中包

含了以下可以引发动态面板交互的动作： 

 Set Panel state(s) to State(s) 

 Show Panel(s) 
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 Hide Panel(s) 

 Toggle Visibility for Panel(s)  

 Move Panel(s) 

选择其中一个动作后就可以和动态面板进行交互，并且可以在对话框下部的“Actions 

descriptions”选择一个要链接的状态。 

 

在控件注释和交互面板中，可以在 Label输入框中对动态面板进行标识，以后就可以引

用这个动态面板。如果没有为动态面板指定 label，动态面板会被标识为“Unlabeled”。 
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5. 动态面板使用案例 

Tab页签 

动态面板可用于创建一个 Tab页签控件。如 Tab页签控件有 3个 tab，则该 tab控件被

包含在拥有 3个状态的动态面板中，每个状态代表一个 tab。对每个 tab都有一个交互动作，

当点击某个 tab时，就会切换到动态面板的对应状态。 

 

弹出菜单 

动态面板可以用于在原型中自定义弹出菜单，或根据鼠标移动动态的显示和隐藏菜单，

这可以结合 OnMouseEnter事件和动作来实现。 

 

页面动态初始化 

动态面板和 OnPageLoad事件结合，可实现根据变量值进行页面初始化。 
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第2节 翻转效果和鼠标移动事件 

1. OnMouseEnter 和 OnMouseOut 事件 

在文本类控件、按钮类控件、超级链接控件中有 OnMouseEnter 和 OnMouseOut 事件。

OnMouseEnter 事件是当鼠标移入到一个控件上时发生，OnMouseOut 事件是当鼠标移出控件

外时发生。 

 

OnMouseEnter 和 OnMouseOut 事件常常和动态面板一起使用，在原型中实现如菜单弹

出、状态翻转、自定义提示等功能。 

2. 图片翻转和按钮样式翻转 

不使用 OnMouseEnter, OnMouseOut和动态面板，也可实现图片翻转、按钮样式翻转。 

图片翻转 

拖入 image 控件到线框图中，右键菜单选择“Edit Image->Import Rollover Image”，

然后选择一张翻转图。用鼠标移入到线框图中图片上的“黑白”小方框上进行效果预览。 

按钮样式翻转 

拖入 Rectangle控件到线框图中，右键菜单选择“Edit Button Shape->Edit Rollover 

Style”，在 Set Rollover Style 对话框中可以修改翻转的样式。应用样式后，在线框图中

用鼠标移入到线框图中按钮左上角的“黑白”小方框上进行效果预览。 
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第3节 菜单 

1. 菜单控件 

菜单控件用于创建简单的弹出菜单，如一般桌面应用软件中的菜单。 

菜单控件分为垂直菜单（Vertical Menu）和水平菜单（Horizontal Menu），可以通过

控件面板中拖拉菜单控件到线框图面板中创建菜单，默认情况下菜单带有 3个菜单项。 

 

2. 编辑菜单控件 

双击菜单项可以编辑菜单文本，通过工具栏可以对菜单加底色、字体和其它样式。右键

单击选择 Edit Menu Padding，在弹出的 Menu Padding Editor 对话框中可设置边距。 

 

要增加或删除菜单项，右键单击选择“Add Menu Item ”和“Delete Menu Item”。 
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要为某个菜单项添加子菜单，在菜单项上右键单击选择“Add Submenu”。 

 

3. 菜单样式翻转 

右键单击菜单或菜单项，选择“Edit Rollover Style”，在弹出的“Set Rollover Style”

对话框中你可以为一个菜单项、所有菜单项、所有子菜单添加动态样式翻转效果。选择

Preview复选框，你可以对所应用的菜单样式翻转效果进行预览。 

应用样式之后，可以将鼠标移到菜单项左上角的“黑白”小方框上进行翻转效果预览。 

 

第四章  高级功能（Rich Function） 

第1节 逻辑条件（Conditional Logic） 

1. 什么是逻辑条件 

良好的条件说明（Case description）可以成为一个有效的流程沟通的方法，且非常易

于维护和更新。但如果需要更强大、更高保真度的原型，就需要条件逻辑。 

可以在你设计的任何交互中添加条件逻辑，条件可以是基于原型中控件输入的值，如：

复选框的选择值、文本框中的文本等；另外，条件也可以是基于变量值。 

2. 创建逻辑条件 

要添加条件，首先要在交互面板中为某个事件添加一个场景（case）。在 Interaction 

Case Properties对话框中的 Step 1中点击“Add Condition„”。 
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这时会打开一个 Condition Builder对话框，该对话框用于创建逻辑条件，如： 

“ If text on widget UsernameField equals 'axure' and text on widget 

PasswordField equals '12345'”。 

 

在 Condition Builder 对话框中，可以添加多行条件。点击“+”按钮可以增加一行条

件，点击“-”按钮可以删除一行条件。 

如果要求所有条件都需要满足，则在 Satisfy 下拉列表框中选择“all ”，即各个条件

行之间是“And”关系；如果 Satisfy 下拉列表框中选择为“any”，则只要满足其中一个条

件，即各个条件行之间是“or”关系。 

在一个条件语句中，有以下 6种类型的值可以使用： 

 文本框、文本域中的文本 
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 复选框和单选按钮的选择值（选择或未选择） 

 下拉列表框、列表框中的选择项 

 控件值的长度 

 变量值 

 变量值的长度  

在 Condition Builder 对话框中点击 Ok 按钮，回到 Interaction Case Properties 对

话框，这时就可以选择当条件满足时要执行的动作了。 

注意：这时在控件交互面板中的场景描述（Case1）位置后面包含了一个“If”条件语

句描述，同时 OnClick事件前面的图标也被加为高亮的绿色，表示在事件上使用了条件。 

 

在事件的一个场景上定义了一个条件后，为事件的后面其它场景添加的条件语句的前面

会默认带有“Else If”。如果后面场景没有添加条件，则会默认为“Else If True”  

 

默认情况下，当条件语句的值为“True”时，原型中只会执行第一个场景。 

“Else If”可以被修改为“If”，只要在交互面板中右键单击场景，选择“Change to IF”

菜单。这样，只要多个条件都成立，就可以执行多个动作。 
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第2节 OnChange 事件 

1. 什么是 OnChange 事件 

OnChange 事件可用于下拉框（Droplist）和列表框（List Box）控件。OnChange 事件

是在下拉框或列表框的选项选择时发生。这在原型中以下拉框进行导航非常有用，即当选择

下拉框的某个选项时跳转到相应的页面上。 

 

2. 在 OnChange 事件上使用条件 

在 OnChange事件中的场景上也可以添加条件。在 Interaction Case Properties 对话

框中的 Step 1中点击“Add Condition„”，然后在 Condition Builder对话框中设置条件。 

在 OnChange 事件上的场景中，可以用“selected option of”条件语句，进行下拉框

或列表框中的值对比，例如“if selected option of droplist equals selected option of listbox”。 

 

第3节 OnKeyUp 事件 

1. 什么 OnKeyUp 事件 

OnKeyUp事件可用在 Text Field 和 Text Area控件上，当用户在控件中进行输入、松
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开键盘按键时发生，常用于打字时的对键盘的响应。 

2. OnKeyUp 实时表单验证 

OnKeyUp 事件常用于用户在表单中进行输入的实时校验。例如，验证输入的字符长度、

用户名是否已经存在、验证码是否正确等，并在界面上进行动态信息提示。  

 

下图是用 OnKeyUp 事件实现的当输入的邮编不符合 5个字符长度的两个状态： 

 

 

第4节 OnFocus 和 OnLostFocus 事件 

1. 什么是 OnFocus 和 OnLostFocus 事件 

OnFocus 和 OnLostFocus 事件可用于 Text Field, Text Area, DropList, List Box, 

Checkbox 和 Radio Button 控件上。OnFocus事件是当是当鼠标点击控件或用键盘 tab键让

控件获得焦点时发生；而 OnLostFocus事件正好相反，是当控件失去焦点时发生。 

2. 使用场合 

OnFocus 和  OnLostFocus 常用于显示、隐藏与表单中控件相关的动态信息。

OnLostFocus也常用于当控件失去焦点时，触发对控件中输入的数据的验证。 
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第5节 变量（Variables） 

1. 什么是变量 

变量用于在原型中页面之间的数据存储、传递和保持。Axure的一个页面中可最多使用

25个变量。变量也可以在交互场景和交互条件中使用。 

2. 管理变量 

在主菜单中选择“Wireframe->Manage Variables”，在弹出的 Manage Variables 对话

框可以进行变量的管理：添加、删除、重命名、排序。 

默认时，每个页面中都有一个 OnLoadVariable 变量。新创建的变量的名必须为字符和

数字，不能大于 25个字符长度，且不能含有空格。 

 

3. 设置变量的值 

在添加场景时弹出的“Interactions Case Properties”对话框中，只要在 step2中选

择 “Set Variable and Widget Value(s) equal to Value(s)”这个动作，然后在 step3

中点击“Variable and Widget value equal to Value”这个链接，就可以在弹出的 Set 

Variable and Widget Value 对话框中设置变量的值了。 
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在以上对话框中，可以设置动作如：“Set value of variable OnLoadVariable equal to 

‘loggedin’”,即让变量 OnLoadVariable的值等于“loggedin”。 

4. 在条件中使用变量 

在 Condition Builder 对话框中，可以在设定的条件中使用变量，例如 if value of 

variable OnLoadVariable equals ‘loggedin’。 

 

5. 在设置文本时使用变量 

当使用动作 Set Variable and Widget Value(s) equal to Value(s)设置文本内容时，

可以在文本面板中插入变量值。 
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当在文本类控件中编辑文本时，在 Set Variable and Widget Values 对话框中你可以

用符号[[ 和 ]]包住一个变量名，就可以在原型中插入变量值。 

例如，可以设置 text panel 控件的文本为“Welcome, [[NameVariable]]”。 

 

第6节 OnPageLoad 事件 

1. 什么是 OnPageLoad 事件 

原型中加载页面时，会发生 OnPageLoad事件。OnPageLoad事件常用于设置动态面板的

状态、控件的值、或页面载入时弹出一个窗口。 

模块上也有 OnPageLoad事件，当包含模块的页面载入这个模块时，模块上的 OnPageLoad

事件就会发生。页面上的 OnPageLoad事件触发后才触发模块上的 OnPageLoad事件。 

OnPageLoad事件是在页面备注面板中的 Interactions 区域中进行定义，在 OnPageLoad

事件上添加场景的方法和在控件事件上添加场景的方式相同。 

 

2. OnPageLoad 事件和变量 

OnPageLoad事件常和变量一起使用，以达到在原型中的页面之间传递变量值的目的。 

OnPageLoad 事件中常有基于变量值条件的场景。例如，你可能会根据变量的值去设定

页面载入时的动态面板的状态，显示一个用户是否已经登陆；或者用存储在变量中的用户名

去设置 text panel控件中的文本，如：“Welcome, [[UsernameVariable]]”，设置页面载入

时的对当前用户的欢迎信息。 
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第五章  模块的最大化重复使用 

第1节 控制模块中控件 

1. 模块的重用 

模块的一个重要作用就是可以重复使用。你可以将设计中可重用的部分做成模块，只需

要改变模块中的一个地方，就可以修改所有相关的地方，使得维护非常方便。 

有些模块可能需要在不同的页面上有所不同。例如，对于作为导航元素的模块，在不同

页面上所要显示的“加亮元素”要不同；或者对于作为 header 头部的模块，在不同页面上

时需要显示不同的标题文字。虽然这些应用例子也可以通过为每个页面创建一个额外的模块

或在每个页面上做一些特别的编辑来实现，但是利用一些特别的功能，仍然可以只在一个模

块中进行维护。 

2. 模块中的动态面板 

在页面中可以操作所包含模块中的动态面板。例如，页面 OnPageLoad 事件可以隐藏该

页面中包含的模块中的动态面板，在所选择的模块下面会列出模块中的每个动态面板。 

 

如果模块中的一个部分只在某些页面上显示而在其它页面上不显示，这可以通过设置模

块中的动态面板的状态来实现。所以你可以只需要维护一个单独的模块，最大化的实现模块

的重复使用。 
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3. 设置模块中的控件值 

在页面中可以操作所包含的模块中的控件。 

例如，在页面的 OnPageLoad 事件上，在动作 Set Variable and Widget value equal to 

Value中，你可以对所包含的模块中的 text panel控件设置文本。当你选择 text on widget

设置控件的文本时，将看到在所选择的模块下列出了模块中所包含的控件。 

 

如果一个模块中的文本控件在不同页面上有不同的文本，你仍然可以只在一个单独的模

块中进行维护，达到模块最大化利用。 

4. 设置条件 

同样地，模块中的控件也可被用于包含该模块的页面中的条件语句中。 
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第2节 模块自定义事件（Raised Events） 

1. 什么是自定义事件 

可以在模块上自定义事件。 

当需要在同一模块的不同实例上实现不同的交互时；或者当和一个模块进行交互时，要

在模块之外对模块中的控件进行操作，自定义事件就尤其有用。 

当你和一个模块的交互在所有模块的实例上都一样时；或者当和一个模块进行交互时，

不需要在模块之外对模块中的控件进行操作，就不需要使用自定义事件。 

2. 管理自定义事件 

要为模块添加自定义事件，首先必须中打开模块，然后点击主菜单“Wireframe->Manage 

Raised Events（Masters Only„）”，在打开的 Manage Raise Event对话框中可以管理自定

义事件：添加、删除、重命名、排序。 

 

任何在模块中的控件都可以触发模块的自定义事件。例如，模块中的按钮 OnClick事件

可以包含一个触发 Raised Event动作的场景。这可以通过在 Interacton Case Properties

对话框中选择 Raise Event 动作达到。 
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在上图中，点击“Event”链接，在所打开的 Manage Raised Events对话框中选择要触

发的模块自定义事件。 

 

最后，当你在线框图中使用这个带自定义事件的模块时，在控件交互面板上你可以看到

这个自定义事件。模块自定义事件可以像其它事件一样添加场景、动作、条件。 

 

模块自定义事件 
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第六章  多人协助和版本管理 

第1节 Axure 共享工程（Shared Project） 

1. 什么是共享工程 

一个共享工程是可以被多人同时编辑，共享工程中也保存着工程被修订的历史。 

一个共享工程是被存储在一个普通的文件目录中，该目录可以被那些允许访问共享工程

的网络上的人所访问。Axure共享工程所存储的服务器或计算机上不需要安装额外的软件。 

 

在 Axure中操作一个共享工程和在版本控制系统中操作文件是类似的，每个人在自己本

地计算机上都有一个共享工程的副本。如果要修改页面、模块、或工程属性，首先需要对这

些项目进行检出（checked out），等完成修改后，再进行检入（checked in）到共享工程中，

其它人就可以在本地获取所更新的共享工程了。事实上，就是用 SVN在进行共享工程的版本

控制。 

2. 创建共享工程 

在主菜单中，通过 File->New Shared Project，就可以创建一个新共享工程。这时会

弹出一个创建共享工程的对话框，根据指示去输入工程名、共享工程的目录地址、本地共享

工程的副本。 
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创建共享工程后，在你的本地计算机上会有一个[ProjectName].rpprj文件，并会自动

打开。今后只要打开这个[ProjectName].rpprj文件，就可以操作共享工程，而不需要再从

远程的共享工程中去获取，除非你想创建一个新的副本。 

本地共享工程目录中，有一个.rpprj 文件和一个 DO_NOT_EDIT 文件夹，该文件夹中包

含了工程数据和版本控制信息，不能在 Axure 以外进行编辑。如果你要移动.rpprj 文件，

同时你也要一起移动 DO_NOT_EDIT 这个文件夹。 

 

在网络共享目录中，包含有共享工程，该共享工程中包含有和 SVN关联的一系列文件和

目录。如果你不熟悉 SVN，也不应该直接去修改这些目录中的内容。 
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3. 从已有 RP 文件创建共享工程 

已有的.rp文件可以被转化为共享工程。打开.rp 文件，然后选择主菜单 Share->Create 

Shared Project from Current File。这时也会打开创建共享工程的对话框，进行工程的设

置。 

在共享工程创建之后，在你的本地目录中会有一个[ProjectName].rpprj 文件，打开这

个文件就可以操作共享工程。原来的.rp文件和共享工程没有产生关联。 

4. 获取共享工程 

为了操作一个共享工程，你使用的计算机上必须有一个共享工程的本地副本。要获得共

享工程的一个本地副本，在主菜单中 Share->Get and Open Shared Project，这时会弹出

获取共享工程的对话框 
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如 果在你的 计算机 上已 经有一个 原先创 建的 共享工程 的副本 文件 ，即

[ProjectName].rpprj 文件，你可以直接打开该文件就可以操作共享工程。 

如果从一个计算机上直接拷贝共享工程的本地副本到另一计算机上，会导致工程的冲突。

如果你在多个计算机上工作，可以在还没有共享工程本地副本的计算机上通过主菜单

Share->Get and Open Shared Project 获取和开打共享工程。 

5. 编辑共享工程 

打开 Axure 共享工程后， Axure 的环境会有一些改变。在 Sitemap 面板中的页面和

Masters面板中的模块前面会有一些不同的图标，表示页面和模块的状态。 

 

另外，在所打开的线框图的上面有一个工具栏，包含了当前状态信息和修改状态的按钮。  

 

如果要修改页面或模块，要进行检出（Check Out）。要共享你的修改，可以发送修改（Send 

Changes）；或者你如果要提交修改，可以进行检入（Check In）。要获取最新更改，使用获

取修改（Get Changes）。  

工程属性包含有注释域、页面注释域、变量、样式和产生器（annotation fields, page 

notes fields, variables, styles, and generators）也需要检出（checked out）以进行

修改。而 sitemap 和 master 面板中的列表是个例外，它们可以不用检出就可以修改，这样

可以让团队能够同时添加、删除、组织页面。 

检出（Check Out） 

要在一个共享工程中编辑页面、模块、或工程属性，要先进行检出。要检出一个页面，
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在页面导航面板中右键点击页面，选择“检出”。页面检出时，会先对共享工程中已修改的

页面和工程属性进行更新。在页面检出之后，就可以进行正常的编辑，所检出的页面只能被

你修改。 

如果你试图检出已经被检出的页面，则会出现警告信息。然而，这时你还是可以继续进

行非安全检出（Unsafe Check Out），但并不提倡这样做，因为这有可能导致冲突。当多人

同时对同一个页面进行修改时，就会发生冲突。只有一个人的修改可以在共享工程中被存储，

其它人的修改可能会丢失或被覆盖。非安全检出一般是在页面（不论何种原因）不能从所检

出的计算机上被检入，或你不能连接到共享目录的情况使用。 

 

提交修改（Send Changes） 

页面或模块的修改也可以通过提交从而被他人共享，这样在保持页面或模块在检出的同

时，所作的修改能被他人共享。 

检入（Check In） 

在页面或模块已经检出和编辑后，你可以通过 File->Save 进行本地保存，而这只是在

你的本地计算机上进行共享工程副本的保存。 

当你要将你的修改提交到共享工程上，就可以进行检入。要检入页面，在页面导航面板

中，鼠标右键单击页面，选择“检入”。检入后，其他人就可以更新他们的本地共享工程副

本看到你所做的修改，而你也就不再拥有页面的编辑权，这时其它人就可以进行检出。 

检入一个页面，可能也需要你同时检入工程属性的修改。 

获取修改（Get Changes） 
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要从共享工程中获取页面、模块、工程属性的最新修改，在页面导航面板中的页面上右

键选择“Get Changes”。当获取页面的修改时，一些工程属性也可能会同时更新。通过主菜

单“Share->Get All Changes from Shared Directory”或工具栏上的“Get All Changes”

按钮达到更新。 

经常为本地共享工程副本去获取最新修改，这是个良好的习惯。 

页面列表和模块列表 

页面和模块列表不用检出，就能在共享工程的本地副本上进行添加、移动、删除、重命

名，这样就能让多人同时进行页面和模块的添加、删除和组织。如果多人同时进行了页面和

模块列表的修改，在工程更新时会自动对列表进行合并。 

要提交对页面和模块列表的修改,选择主菜单“Share->Send All Changes to Shared 

Directory”或“Share-> Check In Everything”将页面、模块、属性的所有修改发送到共

享工程中。要更新本地副本，选择主菜单“Share->Get All Changes from Shared Project”。 

以下是一个页面的编辑和修改共享的典型流程： 

 

 

6. 导出 RP 文件 

打开一个共享工程后，在主菜单选择“File->Export Shared Project to File”，就可

以导出一个共享工程到一个 RP 文件。导出后，这个 RP 文件就可以像普通的 RP 文件一样被

编辑，但已经后共享工程没有关联。 

1、 周群在她自己本地的计算机上检出页面 1 进行编辑。由于同一时间只能有一个人检出

同一个页面，所以这时李剑不能检出修改页面 1； 

2、 周群提交修改和检入页面 1 到网络共享工程的目录中； 

3、 李剑在他自己本地的计算机上获取周群对页面 1 的修改，且现在李剑可以检出页面 1

进行自己的修改。 
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要将 RP 文件做的修改合并到一个共享工程中，可以打开共享工程后然后使用

“File->Import”。但注意，如果你要用导入的页面替换共享工程中的页面，必须先要对共

享工程中的页面进行检出。 

7. 查看共享工程的历史 

每次检入都会在一个共享目录中创建一个新的修订记录。对于每次检入，你可以添加备

注，在修订中保留所作修改的追踪。 

要查看和获取一个共享工程的修订历史，可使用主菜单“Share->Browse Shared Project 

History”。 

 

在上面的历史浏览窗口中，你可以查看共享工程的所有历史修订和每次修订时的备注。

你也可以导出一个修订到 RP文件中进行查看。 

8. 使用共享工程管理器 

使用主菜单“Share->Manage Shared Project”，可以打开一个共享工程管理器对话框，

在该对话框中你可以查看共享工程中每个项目的状态，例如哪个团队成员在对哪个页面或模

块进行检出。 
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右键单击刷新按钮你可以重新获取页面、模块、共享工程的文档属性。你也可以右键单

击某个项目（行），选择检入、检出、获取最近更新。 

9. 移动共享工程目录 

如果一个共享工程被移动或共享工程的目录路径被改变，那么已有的共享工程的本地副

本将不再指向正确的地址。强烈建议在共享工程目录改变前对每个本地共享工程的副本先进

行检入。 

要重新指向一个已有的本地共享工程到新的共享工程目录上，可打开已存在的副本，然

后使用主菜单“Share->Repoint to Moved Shared Directory”。 

使用主菜单“Share->Get Shared Project”，你也可以获取一个新的本地副本，但是如

果你进行了任何的本地修改或任何页面被检出，当共享工程被移动了时，这些修改和检出状

态将不再被保留。 
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案例篇（未完） 

案例一 简单登陆界面 

案例描述 

这是一个较为简单的登陆界面，输入用户名、密码后，点击登陆按钮进行登陆校验： 

1. 如果未输入用户名或密码，则提示“请输入用户名和密码”，蓝色字体； 

2. 如果用户名或密码错误，则提示“用户名或密码错误”，红色字体； 

3. 如果用户名和密码都匹配，则提示“您好，【用户名】”，黑色字体。 

实现步骤 

步骤一、绘制线框图 

1、 打开 Axure 软件，新建一个 RP 文件； 

2、 拖动控件面板中的控件到线框图面板中，绘制登陆界面如下图： 

 

所用到的控件清单如下： 

控件名 作用 文本内容 标识符 其它属性 

Rectangle 装饰底板   底色：灰色 

Text Panel 信息提示 默认：登陆窗口 logInfo  
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Text Panel 信息提示 用户名：   

Text Panel 信息提示 密码：   

Text Field 输入用户名  userName  

Text Field 输入密码  passWord  

Button 点击登录 登陆 submitButton  

步骤二、设计控件交互 

1、 选中登陆按钮，在控件交互和注释面板中鼠标双击 onClick 事件； 

 

2、 在弹出的“交互场景属性”对话框中，点击“添加场景…”这个链接；  
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3、 在弹出的“条件创建”对话框中，添加条件如下： 

 

4、 回到“交互场景属性”对话框中，Step 2 中选择动作“Set Variable and Widget value 

equal to Value”，并点击 Step 3 中的链接； 

 

5、 在弹出的“设置变量和控件值”对话框中，设置如下： 
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点击 Edit text…链接，输入“请输入用户名或密码”，并设置为蓝色； 

6、 确定和关闭所有对话框，这时控件交互和注释面板如下： 

 

以上我们实现了第一个场景：如果未输入用户名或密码，则提示“请输入用户名和密码”，

蓝色字体； 

接下去，我们实现第 2、3 个场景，其步骤和实现场景 1 类似，只是要注意各个场景之

间是“If else”关系。最终控件面板上的场景、条件、动作如下： 

 

步骤三、生成原型 

1、 点击主菜单“Generate->Prototype…(F5)”，选择要生成的原型地址，确定后就可以

在浏览器中查看原型了。 

2、 输入用户名和密码，点击登陆按钮，进行原型体验。 
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案例二 Tab 页签控件 

案例三 可选择和带滚动条的网格 

案例描述 

效果展示 

详细步骤 

Scrollbars on Tables and Other Widgets Using the Dynamic Panel  

There are a couple ways to represent scrollbars on tables or other sections in wireframes in 

Axure RP. The first is to simply use an image of a scrollbar on the wireframe, but with this 

method the scrollbars are static in the prototype. 

The second way is to use the dynamic panel. This tutorial will go through the steps to put a 

scrollbar on a table widget, but it can be used in general for any widget or collection of widgets 

on a wireframe. 

1. Drag a dynamic panel from the Widgets pane onto the wireframe. 

2. Right-click on the dynamic panel and select Edit Dynamic Panel -> Show Scrollbars As 

Needed. This will show scrollbars on the dynamic panel in the designer. 

3. Double-click the dynamic panel to open the Dynamic Panel State Manager. 

4. Double-click on State 1 in the Panel State list to design the wireframe for the panel state. 

5. Drag a table from the Widgets pane onto the wireframe. 

6. Specify the number of rows and columns. The width and/or height need to be wider or taller 

than the dimensions of the dynamic panel for the scrollbars to appear in the prototype. 

7. Design the table as desired and resize the dynamic panel as needed. 

8. Generate the prototype (F5) and you will see scrollbars on the dynamic panel surrounding 

the table (if the table is wider or taller than the panel). 
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秘笈篇 

1、 解决中文输入法问题 

目前 Axure对中文的一些输入法支持得不好，搜狗拼音输入法没有办法使用，用谷歌拼

音问题不大，但会强制转为全角，需要人为点击一下转为半角。 

2、 超快速移动工作区 

当设计的页面画面变大时，为了选取不同位置的对象，必须经常使用垂直与水平的滚动

条，这会使得选取对象的动作变慢。请试试这招：鼠标光标 focus在 Wireframe 中，按住键

盘的空格键，此时鼠标光标会切换成手状，您可以用来抓着画面任意滑动，而且不会打乱任

何对象的位置，轻松愉快。 

3、 穿透控件选取下层的控件  

以鼠标左键在对象上按住停留 1秒钟以上，放开鼠标左键再单击下面的对象，可以穿透

上层对象，选取到位于下层的对象 。 

4、 引用 Microsoft Office 或其他软件的对象： 

利用复制、粘贴功能，将其他应用程序中如：PowerPoint, Excel, Visio, Photoshop 与

Illustrator中的物件，粘贴到 Axure RP中。一般来说，这些粘贴的对象会变成 Wireframe

中的图形对象。反之亦然，也可以复制 Axure中的对象或画面，粘贴到其他应用程序。 

5、 单选群组（Radio Button Group） 

您可以一次选取多个 Radio Button，按下鼠标右键，并选择“Edit Radio Button->Assign 

Radio Group”来设定 Radio Button的群组关系。如此一来，当这些 Radio Button 输出到

Prototype时，就会形成真正的单选用户接口。 

6、 解除 IE 中的 Active X 警告讯息 

使用 IE打开在自己计算机里头的 HTML原型时，浏览器中可能会出现 Active X 警告讯

息，想要暂时解除 IE 中的警告讯息，请点选 IE浏览器出现的 Active X 警示讯息，接着选

择“允许被封锁的内容”，这样就可以在 IE浏览器上看到自己计算机里头的 HTML 原型了。 
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7、 只要输出必要的项目到规格书中 

规格文件输出时如果选择输出的项目太细，很有可能会产出一份好几百页的 Word文件，

难以阅读。因此，输出之前最好通过格式的设定将不需要的项目取消勾选，只保留有意义的

部份。 

8、 默认规格书标题改成中文 

将 Axure设置格式的文件标题改成中文，比如将 Pages格式设定的 Section Header名

称“Pages”改成“软件规划说明”，把“Page Tree”改成 “界面列表”；或者把

Screenshot 格式设定的 Section Header 名称“User Interface”改成 “用户画面”。如

此一来输出成规格文件时，会更方便阅读这些段落标题。 


